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AA Save where otherwise stated, illustrations are from Windows 10. Default camera and software settings are assumed.

AA The links at the top of each page can be used for chapter navigation. Click  to return to this page.

D Notices
• No part of the manuals associated with this product may be reproduced, transmitted, tran-

scribed, stored in a retrieval system, or translated into any language in any form, by any means, 
without Nikon’s prior written permission.

• Nikon reserves the right to change the specifications of the hardware and software described in 
these manuals at any time and without prior notice.

• Nikon will not be held liable for any damages resulting from the use of this product.
• While every effort has been made to ensure that the information in this manual is accurate and 

complete, we would appreciate it were you to bring any errors or omissions to the attention of 
the Nikon representative in your area (address provided separately).

A Trademark Information
Microsoft, Windows, and Windows Vista are either registered trademarks, or trademarks of 
Microsoft Corporation in the United States and/or other countries. macOS and OS X are regis-
tered trademarks of Apple Inc. in the United States and/or other countries. All other trade names 
mentioned in this manual or the other documentation provided with your Nikon product are 
trademarks or registered trademarks of their respective holders.
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What Capture NX-D Can Do for You
Capture NX-D lets you fine-tune pictures by, for example, adjusting brightness 
and hue, and can also be used to edit RAW images taken with Nikon digital cam-
eras and save them in other formats.

Fine-Tune Pictures
With Capture NX-D, it’s easy to adjust such settings as brightness and white balance 
(page 18). Certain settings, such as exposure compensation and Picture Controls, 
are available only with RAW images.

Copy Adjustments
Save adjustments and apply them to other images (page 33) or copy them to other 
computers (page 35). Saved adjustments can be applied to multiple images using 
batch processing (page 40).

Save Pictures in Other Formats
Fine-tuned or processed RAW (NEF/NRW) images can be saved in JPEG or TIFF 
formats for use in other applications (page 36).

.NEF .JPG .TIF
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What Capture NX-D Can Do for You

Fine-Tuning Pictures in Capture NX-D
Capture NX-D stores image adjustments in a separate “sidecar” file that is up-
dated automatically as settings are changed.

Image data

Picture Control settings

Exposure compensation

Settings file

Because changes to settings are stored separately from the original image data, 
the original picture can be restored at any time with no drop in quality.

Original image

Settings

Fine-tuning preview

Fine-tuning preview

Settings file deleted or 
settings reset

Original image

When files are converted to JPEG or TIFF, the changes are applied to the image as 
it is saved to create a new, modified image data file.

Settings 

Original image JPEG or TIFF file
A Image Adjustments
Image adjustments are stored in a “NKSC_PARAM” folder in the same folder as the original image. All 
changes will be lost if this folder or the image adjustment file is deleted; similarly, because the image 
and the image adjustment file are linked via the file name, changes will be lost or applied to another 
image if the image adjustment file is renamed. 

When opening images modified in ViewNX-i, Capture NX-D also reads the associated settings files 
and preserves the adjustments they contain.
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Hiding Changes Made in Capture NX/Capture NX 2
Capture NX-D can be used in combination with 
Capture NX and Capture NX 2. To hide changes 
made using Capture NX or Capture NX 2, click 
the  button in the edit palette (page 7) to 
display the Version tool and deselect Apply 
adjustment steps. This applies only to modifi-
cations made using the tools in the “Enhance-
ment Steps” (Capture NX) or “Adjust” section 
(Capture NX 2); images modified using these 
tools are indicated by  icons in the thumb-
nail list.

Version
n Apply History Setting
The image below has been modified using the Picture Control tool in the 
“Develop” section and the Gaussian Blur tool in the “Adjust” section of 
Capture NX 2. Deselecting Apply adjustment steps in Capture NX-D hides only 
the effects of the “Gaussian Blur” tool.

Apply adjustment steps: Apply adjustment steps: 

n Unsupported Images
Images that have been modified using the 
Color Efex Pro plugin for Capture  NX or 
Capture   NX  2 can be fine-tuned in Capture 
NX-D by first resetting all changes using the re-
vert button in the edit palette  (page 7). Pictures 
that have been modified using Color Efex Pro 
are indicated by  icons in the thumbnail list.

Revert button

A RAW (NEF/NRW) Images
Changes made to RAW (NEF/NRW) images in Capture NX-D, including those made using the revert but-
ton, are not reflected in Capture NX or Capture NX 2. RAW (NEF/NRW) images opened in Capture NX or 
Capture NX 2 will be restored to the state they were in when they were last saved in these applications, 
regardless of any changes made in the interim using Capture NX-D.

A NEF Conversion
JPEG or TIFF images converted to NEF in Capture NX or Capture NX 2 are treated as JPEG or TIFF 
images in Capture NX-D and can not be modified using options such as exposure compensation 
(page 20) and white balance (page 21) that apply only to RAW (NEF/NRW) images.
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The Capture NX-D Window

e r
t

y

u

i

w
q q Menu bar: Access the menus (page 9).

w Toolbar: Choose a view and access image ad-
justment tools (page 8).

e Folder palette: Select a folder to display its con-
tents in the image area (page 6).

r Image area: View the images in the current 
folder.

t Selected image: Selected images are high-
lighted in gray, with images that have been 
modified indicated by a  icon at the top left 
corner of the thumbnail. Double-click to pre-
view (page 10).

y Histogram palette: View the tone distribution 
for the selected image (page 6).

u Edit/metadata palettes: Fine-tune images using 
the tools in the edit palette or switch to the 
metadata palette to view image information 
(page 7).

i Status bar: View information on the selected 
image (page 9).

A The Navigation Palette
A navigation (bird’s eye) palette (page 6) appears when a preview is displayed by double-clicking a thumbnail in the image area.
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Palettes
Capture NX-D offers the following palettes.

The Folder Palette
The folder palette lists the folders in the com-
puter’s storage system. Click a folder to view 
the images it contains in the image area or pre-
view display.

The folder palette menu gives access to recent 
folders. Frequently-used folders can be added 
to and then accessed from this menu.

Folder palette menu

The Histogram Palette
The histogram palette provides a constantly-
updated histogram for the selected thumbnail 
or the image in the preview display. The histo-
gram shows the tone distribution for the color 
channel selected in the channel menu. Choose 
RGB to view overlapping distributions for the 
red, green, and blue channels: tone ranges in 
which the distributions for red and green over-
lap are shown in yellow, those in which red and 
blue overlap in magenta, those in which green 
and blue overlap in cyan, and those in which all 
three colors overlap in white.

The Navigation (Bird’s Eye) Palette
The navigation palette is displayed above the 
folder palette when you double-click a thumb-
nail to display a preview. To zoom the preview 
in and out, click the  and  buttons, use the 
slider, or enter the desired zoom ratio in the 
text box.

When the preview is zoomed in, the frame 
in the navigation palette shows the area cur-
rently displayed. Drag the frame to view other 
areas of the preview.

Channel menu

A Palette Menus
To access the palette menu, click the triangle ( ) at the top right corner of the palette. Select Undock 
to open the palette in a floating window that can be moved freely about the display.
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Palettes

The Edit Palette
Use the tools in the edit palette to adjust 
the image currently selected or previewed 
in the image area. The tool list (page 18) offers 
Exposure Compensation, White Balance, 
Picture Control, and Tone/Tone (Detail) tools 
that can be accessed via pull-down menus or 
by clicking the tool icon and adjusting settings 
in the adjustments palette (page 18). Additional 
tools can be accessed using the tool buttons 
(page 19) at the bottom of the palette. The 
adjustment manager tool (page 19) can be used 
to copy adjustments to other images or save 
current settings for later use. To reset all tools 
and restore the image to the state it was in 
when first opened in Capture NX-D, click the 
revert button (note that any changes made to 
JPEG and TIFF images in other applications 
since they were last opened in Capture NX-D 
will not be reset).

Tool listEdit tab
Adjustment manager

Tool buttons

Adjustments palette

Revert button

A The Edit and Metadata Palettes
Use the tabs at the top left corner to switch between the edit and metadata palettes.

The Metadata Palette
The metadata palette lists information on the 
image currently selected or previewed in the 
image area, including exposure, the model of 
camera used to record the picture, and the 
date and time of recording. The metadata pal-
ette can be displayed in the position normally 
occupied by the folder palette (page 6)  by se-
lecting Dock to Left in the palette menu.

Metadata tab
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The Toolbar
Use the toolbar to choose a view and access image adjustment tools.

q w e rtyui o!0!1!2!3!4!5!6!7!8 !9@0@1@2

q Back/Foward Select the folder before or after the current folder. —

w Folder Display a dialog where you can navigate to and open a folder. Page 6

e View Mode Choose a view mode for the image area. Page 10

r Multi View images side-by-side. Choose from Compare Before and 
After Images and 2 Images.

Page 13

t Current Apply current adjustments to the “before” image for use as a refer-
ence when making further modifications.

Page 13

y Original Restore the “before” image to the state it was in before any adjust-
ments were made.

Page 13

u NEF/NRW + JPEG
If the folder contains images shot at image quality settings of “RAW 
+ JPEG”, select this option to list the RAW and JPEG copies sepa-
rately.

Page 10

i View Tool Access the fit, image viewer, zoom, and hand tools. —

o WB
Click a point in the preview to adjust white balance so that the 
sampled point takes on a neutral gray color  (gray point sample 
tool).

Page 21

!0 Straighten Straighten images. Page 30

!1 Crop Crop images. Page 37

!2 Rotate Rotate images 90°. The direction of rotation can be selected by 
keeping the button pressed.

—

!3 Retouch Brush Remove dust and scratches (auto retouch brush). Page 39

!4 Filter by Rating/Label Filter images by rating or label. Page 17

!5 Filtering Filter images by rating, label, or camera settings. Page 17

!6 Clear Filtering End filtering and view all images. —

!7 Batch Process Status View batch process status. Page 40

!8 Cancel Batch Process Cancel batch processing. —

!9 ViewNX-i

View the current image or images in ViewNX-i. The images are dis-
played in their current state including any changes made using 
Capture NX-D and, in the case of NEF/NRW (RAW) images, without 
conversion to TIFF.

—

@0 Open with Open images in an application and format previously selected us-
ing the Open With Application option.

Page 47

@1 Print Print the image currently selected or previewed in the image area. Page 42

@2 Convert Files Save images in JPEG or TIFF format. Adjustments are applied be-
fore the image is saved.

Page 36
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The Status Bar
View information on the image selected or previewed in the image area.

q w e r t y

q File name The file name.

w Zoom ratio The zoom ratio at which the preview is currently displayed.

e Color space The color space of the image in the preview display.

r Image size The size (in pixels) of the image in the preview display.

t Color value The color of the pixel under the cursor in the preview and image 
viewer displays.

y Position in folder The position of the current image and the total number of images 
in the folder. Click  or  to view other images.

The Menu Bar
Access image adjustment tools or save images in other formats.

q w e r t y u i

q File Convert files to other formats, run batch processes, and print and rename files.

w Edit Select, copy, paste, and delete images.

e View Choose a view mode, adjust zoom, and sort and select images.

r Image Rotate, rate, and label images or display a grid or the focus point, shadows, or highlights.

t Adjust Copy, paste, save, and load image adjustment settings.

y Tool Access image adjustment tools.

u Window View and hide palettes.

i Help View online help. In Windows, this option also displays the current software version number.
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Viewing Pictures
Capture NX-D offers the following viewing options.

Thumbnails
At default settings, Capture NX-D lists the images in the current folder as thumb-
nails. Selected images are highlighted in gray.

Thumbnail list

Selected image

Previews
To display a preview, double-click a thumbnail, or select a thumbnail and then 
click the view mode button in the toolbar and select Preview.

A Thumbnail Size
Use the slider above the image area to choose the thumbnail size.

Slider

A Returning to the Thumbnail View
To return to the thumbnail view, click the view mode button in the toolbar and 
select Thumbnail.

A Same Name, Different Extension
If the folder contains pairs of images with the same file names but different extensions (for example, 
RAW and JPEG images recorded at image quality settings of “RAW + JPEG”), only one copy of each pair 
will be displayed when NEF/NRW + JPEG is on. To view all images, turn NEF/NRW + JPEG off.
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Viewing Pictures

The Image Viewer
To preview the current image with thumbnails above, below, or to one side, click 
the view mode button in the toolbar and select Image Viewer.

Preview palette

Thumbnail palette

Click thumbnails to preview other images.

A Choosing the Location of the Preview and Thumbnail Palettes
The locations of the preview and thumbnail palettes can be selected from the palette menus.

Preview palette menu

Thumbnail palette menu



Capture NX-D Reference Manual 12

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

Viewing Pictures

Viewing Images Full Screen
To hide the menus, toolbar, and palettes and view the current image full screen, 
click the view mode button in the toolbar and select Full Screen.

Use the left and right arrow keys on the keyboard to view additional images.

Full-screen display is also available in the multi-preview view (page 13).

Compare before and after images 2 Images

To exit the full-screen display and return to the previous view, click the  button 
or press the Esc key.
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Side-by-Side Comparison
To compare images, use the “multi” tool in the toolbar. Choose Compare Before and 
After Images to compare before and after views of a single image, or 2 Images to 
compare multiple images side-by-side. To exit the side-by-side comparison display, 
select Single Preview.

Multi 

Compare Before and After Images
Compare before and after views of the current image.

Before After

n Updating the “Before” Image
To update the “before” image to reflect current image adjustments, click the  
button in the toolbar. The “before” image can then be used as a reference for 
subsequent changes to image adjustment settings.

n Restoring the “Before” Image
To restore the “before” image to its unadjusted state, click the  button in the 
toolbar. The “before” image will be restored to the state the image was in when 
first opened in Capture NX-D (note that any changes made to JPEG and TIFF im-
ages in other applications since they were last opened in Capture NX-D will not 
be reset).
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Side-by-Side Comparison

“2 Images”
Compare images side-by-side. When either image is zoomed or scrolled, the 
other will be zoomed or scrolled to match.

Current image

A “2 Images”
Computers with at least 4 GB of memory and 64-bit operating systems 
offer a choice of two- and four-image displays. The “2 images” feature 
on computers running 32-bit editions of Windows offers only a two-
image display.

When you click the “multi” button and select 2 Images, the current image will be 
displayed on the left. To select images for display, click the desired preview box 
and then click a thumbnail. Only images in the same folder can be selected for 
side-by-side comparison.

Click

Click a 
thumbnail

The selected preview is highlighted in white. Image adjustments apply only to 
the selected preview, as do the histogram and navigation palette displays.

No adjustment Exposure compensation set to +1.0 EV

A Comparing Images in the Preview Display
To open the images side-by-side in the preview display, 
click the view mode button in the toolbar and select 
Preview.
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Rating
Pictures can be assigned ratings of from  (no rating) to five stars. Ratings are assigned using the thumbnail rating icons or the Apply Ratings op-

tion in the Image menu.

 1 Select pictures.

AA To select multiple pictures, keep the Ctrl key 
(or on Mac computers, the /command key) 
pressed while clicking each image in turn. To se-
lect two pictures and all images between them, 
click the pictures while pressing Shift.

 2 Click the  icon and choose a rating of from  (no rating) to five stars.

To assign the picture a three-star rating, 
click the third star from the left. The first 
three stars will be highlighted in yellow.

A “Apply Ratings”
Selected files can also be rated using the Apply Ratings option in the Image menu.
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Labelling
To make pictures easier to sort and locate, you can assign them labels of from “0” 
(no label) through “9”, each with its own unique color.

Ratings are assigned using the thumbnail label icons or the Apply Labels option 
in the Image menu.

 1 Select pictures.

AA To select multiple pictures, keep the Ctrl key 
(or on Mac computers, the /command key) 
pressed while clicking each image in turn. To se-
lect two pictures and all images between them, 
click the pictures while pressing Shift.

 2 Click a label (q; in the case of unlabelled images, the label “0” only appears 
when the cursor is over the picture) and choose a label of from “0” (no label) 
through “9” (w).

q Click a label icon.

w Click a label.

A “Apply Labels”
Selected files can also be rated using the Apply Labels option in the Image menu.
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Filtering
To filter pictures using criteria such as ratings, labels, and photo information, 
click the  button in the toolbar.

A dialog will be displayed where you can select 
filters. Only pictures that match at least one of the 
selected criteria will appear in the thumbnail list.

A Filters
The options for the Model, Focal Length, Shutter Speed, 
F Number, and ISO Sensitivity filters are restricted to values 
found in the images in the current folder.

Quick Filters
Use the  button in the toolbar to quickly filter pictures by rating and label.

 1 Click the  button to display the filter bar.

Filter bar

 2 Choose a filter or filters from the options in the filter bar.

AA If you select multiple ratings, all pictures with ratings in the selected range will be displayed. 
For example, selecting ratings of three and five stars displays pictures with ratings of three, 
four, and five stars.

Only pictures that match at least one of 
the selected criteria will appear in the 
thumbnail list.

A Viewing All Pictures
To cancel filtering and display all pictures in the current folder, click the  button in the toolbar.



Capture NX-D Reference Manual 18

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

The Edit Palette
Most image adjustments are performed using 
the edit palette, which consists of a tool list, an 
adjustments palette, and tool buttons.

The Tool List
The tool list contains the items listed below. 
All but Tone/Tone (Detail) apply exclusively to 
RAW (NEF/NRW) images.

Exposure Compensation Page 20

White Balance Page 21

Picture Control Page 22

Tone/Tone (Detail) Page 24

Settings for these tools can be selected from 
the pull-down menus. Selecting Original re-
stores settings to the values in effect when 
the image was first opened in Capture  NX-D. 
At other settings, a check ( ) appears in the 
box to the right of the pull-down menu, and 
changes can be hidden by removing the check 
from the box ( ).

Tool list

Adjustment palette

The Adjustment Palette
Use the adjustment palette to make detailed adjustments. Clicking a tool button 
or an icon in the tool list displays settings for the selected item.

Tools that have been modified using the adjustment palette are identified by the 
label Manual in the tool list pull-down menus.
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The Edit Palette

Tool Buttons
The following tools can be accessed using the 
tool buttons at the bottom of the edit palette. 
Note that some of these tools can be used only 
with RAW (NEF/NRW) images; for information, 
see the section for each tool.

Noise Reduction Page 25

Camera and 
Lens Corrections Page 26

LCH Page 28

Straighten and 
Perspective 
Control

Page 30

Unsharp Mask Page 31

Levels & Curves Page 32

Retouch Page 39

These tools are accessed by clicking the but-
tons and adjusting settings in the adjustment 
palette. The buttons for tools that have been 
modified from default values are highlighted 
in yellow (e.g., ).

Tool buttons

The Revert Button
Click the revert (“Revert to Original State”) 
button to reset all tools and restore the im-
age to the state it was in when first opened in 
Capture  NX-D (note that any changes made 
to JPEG and TIFF images in other applications 
since they were last opened in Capture  NX-D 
will not be reset).

Revert button

The Adjustment Manager Tool
Use the adjustment manager tool to copy ad-
justments to other images or save current set-
tings for later use (page 34).

Adjustment manager

A Fine-Tuning Multiple Images
Image adjustments apply simultane-
ously to all the images currently select-
ed in the thumbnail list.



Capture NX-D Reference Manual 20

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

Exposure Compensation (RAW Images)
Adjust overall exposure, making images lighter 
or darker.

The pull-down menu in the tool list can be used to choose from values between 
+1.0 and –1.0 EV.

+1.0 EV

–1.0 EV

For values between +5.0 and –5.0 EV, 
incremented in steps of 0.01  EV, use the 
Exposure Compensation control in the image 
adjustment palette.

The image adjustment palette also offers an Active D-Lighting menu that can 
be used to bring out details in highlights and shadows.

Low Normal

High Extra high

A Active D-Lighting
Active D-Lighting is available only with RAW images taken using cameras that support Active 
D-Lighting.
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White Balance (RAW Images)
Adjust white balance.

The pull-down menu in the tool list offers a choice of preset values.

Incandes-
cent

Cloudy

White balance can be fine-tuned using the 
Color Temperature and Tint controls in the im-
age adjustment palette. Tint can be set to val-
ues between –12 and +12: choose lower val-
ues for less green and more magenta, higher 
values for the opposite effect. The range of val-
ues available for Color Temperature vary with 
the option selected for white balance.

Gray point sample tool

White balance can also be set by sampling the image: click the  (Gray Point 
Sample Tool) button and click anywhere in the image to sample a single pixel, 
or drag the cursor over the image to use the average color value for the selected 
area. White balance for the entire image will be adjusted so that selected pixel 
or area takes on a neutral gray color.

Blue area sampled White balance adjusted to give blues a gray 
cast and the overall image a “warm” cast
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The controls in the image adjustment palette 
can be used to choose a color reproduction 
process, perform quick adjustments to the se-
lected control, or fine-tune individual Picture 
Control parameters.

Selected Picture Control

Quick Adjust

Color reproduction process

n Color Reproduction Process
Choose one of the following options:
• Latest Picture Control: Colors are processed using the Picture Controls for the latest 

Nikon cameras.
• Camera compatible: Colors are processed using the Picture Controls for the cam-

era that took the picture.

n Quick Adjust
Drag the slider left or right to mute or heighten the effect of the selected Picture 
Control, or click Reset to reset the slider to zero. Quick adjust affects all Picture 
Control settings simultaneously and cancels any changes made separately to 
the individual parameters. It is not available with neutral, flat, or monochrome 
Picture Controls.

Picture Control (RAW Images)
Adjust Picture Control settings.

The pull-down menu in the tool list offers a 
choice of preset Picture Controls.
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Picture Control (RAW Images)

n Picture Control Parameters
Fine-tune individual Picture Control parameters, including sharpening, clarity, 
contrast, and saturation, or select Auto to let Capture NX-D adjust settings au-
tomatically (note that Auto produces results that may vary with exposure and 
the position and size of the subject in the frame). What parameters are available 
depends on the Picture Control selected.
• Sharpening: Control the sharpness of outlines. 

Choose higher values for more sharpening.
• Clarity: Adjust clarity (requires Latest Picture 

Control or a picture taken with a camera that 
supports the Clarity parameter).

• Contrast: Adjust contrast. Choose lower values 
for less contrast, higher values for more con-
trast.

• Brightness: Adjust brightness without losing 
detail in highlights and shadows.

• Saturation (non-monochrome only): Control the viv-
idness of colors. Choose lower values for less 
saturation, higher values for more saturation.

• Hue (non-monochrome only): Adjust hue.
• Filter Effect (monochrome only): Simulate the effects 

of color filters on monochrome photographs.
• Toning (monochrome only): Choose the tint used in 

monochrome photographs.
• Toning Saturation (monochrome only): Choose the 

saturation of the tint used in monochrome 
pictures. Does not apply to black-and-white 
images.

Note that Contrast and Brightness can not be adjusted if Camera compatible is 
selected for pictures taken with Active D-Lighting or a Picture Control that uses 
a custom curve.

A The “AUTO” Picture Control
The parameters for the AUTO Picture Control can be set values of 
from A−2 to A+2.
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Tone/Tone (Detail)
Adjust overall brightness and contrast, or make adjustments that affect only 
highlights and shadows.

Tone
Clicking the icon shown in the illustration dis-
plays the following controls in the image ad-
justment palette:
• Brightness: Adjust overall brightness. Choose 

from values between –100 and +100: the 
higher the value, the brighter the result.

• Contrast: Adjust overall contrast. Choose from 
values between –100 and +100: the higher 
the value, the greater the contrast.

• Saturation: Control the vividness of colors. 
Choose from values between –100 and +100: 
the higher the value, the more vivid (saturat-
ed) the result.

Tone (Detail)
Clicking the icon shown in the illustration dis-
plays the following controls in the image ad-
justment palette:
• Highlight Protection: Preserve details in high-

lights. Values range from 0 to 100: choose 
higher values to reduce brightness in high-
lights.

• Shadow Protection: Preserve details in shadows. 
Values range from 0 to 100: choose higher 
values to increase brightness in shadows.

• D-Lighting HS: Brighten shadows in backlit or 
poorly-lit pictures or reduce loss of detail in 
highlights. Higher values reduce the contrast 
between shadows and highlights.
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Tool Buttons
Use the tool buttons for access to tools not in the tool list.

Noise Reduction
Selecting this tool displays the following con-
trols in the image adjustment palette:
• Noise Reduction: Enable or disable noise 

reduction.
• Method: Select Faster for faster processing, 

Better Quality or Better Quality 2013 for 
more accurate noise reduction. Selecting 
Better Quality  2013 allows separate 
Intensity and Sharpness adjustments for 
Luminance and Color (RAW images only).

• Intensity: Choose from values between 0 and 
100. The higher the value, the smoother 
the image and the less visible the artifacts 
caused by image “noise”.

• Sharpness: Choosing high values for Intensity 
may smooth the image to the point that 
details are lost; this can be countered by in-
creasing Sharpness.

• Edge Noise Reduction (RAW images only): Make out-
lines more distinct by reducing the occurrence of noise artifacts around edges.

• Astro Noise Reduction (RAW images only): Reduce the occurrence of randomly-spaced 
bright pixels in long exposures.

A Better Quality 2013
Better Quality 2013 excels in reducing color noise at short wavelengths and over evenly-colored 
areas of the image.
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Camera and Lens Corrections
Selecting this tool displays the following con-
trols in the image adjustment palette:
• Color Moiré Reduction (RAW images only): To reduce 

color moiré (an image artifact visible where 
regular patterns overlap), select this item and 
choose an option from the menu.

• Image Dust Off (regular- or large-size RAW images only): 
Compare photos with reference data recorded 
using the camera to mitigate the effect of 
dust on the low-pass filter. Click Change… 
to choose the NDF file containing the desired 
data. For more information on recording 
reference data, see the camera manual.

• Lateral Color Aberration: Reduce lateral color ab-
erration (colored fringes and halos) in RAW 
images. At default settings, this option is not 
applied to JPEG and TIFF images.

• Axial Color Aberration: Reduce blurred colors 
caused by axial color aberration. Choose 
from values between 0 and 100: the higher 
the value, the greater the effect.

• Auto Distortion Control: This option uses the lens 
information recorded with photographs to 
reduce the barrel distortion associated with wide-angle lenses and the pin-
cushion distortion associated with telephoto lenses. Auto distortion control 
can be turned on or off from the pull-down menu; if the photograph was taken 
with an advanced camera with interchangeable lens fitted with a waterproof 
lens, you will also be offered an On (underwater) option for reducing pin-cush-
ion distortion in photos taken underwater.

• Auto Red-Eye: Automatically detect and remove “red-eye”.

• Vignette Control: Adjust for variations in peripheral illumination that occur with 
some lenses. Choose from values between –100 and +200: the higher the val-
ue, the greater the increase in brightness at the edges of the image.

• PF Flare Control: Reduce ring flare, circular flare, and other flare effects caused by 
bright light sources in the frame.

• Fisheye: This option is available only with photos taken using AF DX Fisheye-
Nikkor 10.5mm f/2.8G ED, AF Fisheye-Nikkor 16 mm f/2.8D, or AF-S Fisheye NIK-
KOR 8-15mm f/3.5-4.5E ED lenses.
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n Image Dust Off
Follow the steps below to perform Image Dust Off.

 1 Click Change…. If the current folder contains an Image Dust Off reference 
file, a message will be displayed; proceed to Step 2. If no message is dis-
played, proceed to Step 3.

 2 To perform Image Dust Off using the file in the current folder, select Yes. 
Otherwise, select No and proceed to Step 3.

 3 Select a reference file and click OK to perform Image Dust Off.

A Image Dust Off
Dust changes position from day to day; if possible, use reference data recorded in the last 24 hours. 
If the camera offers image sensor cleaning, use only data recorded after the most recent cleaning, as 
cleaning can change the position of the dust.

The AF DX Fisheye-Nikkor 10.5mm f/2.8G ED and AF Fisheye-Nikkor 16mm f/2.8D
If Include areas where there is no image data 
is selected, the image will not be cropped; in-
stead, sections of the image will be bent. The 
bends contain no image data and are filled 
with the color selected in the Fill color menu.

The AF-S Fisheye NIKKOR 8-15mm f/3.5-4.5E ED
The Size of Crop slider controls the size of the 
crop. The smaller the crop, the more the center 
of the image will be enlarged. Choosing values 
closer to 1 with full-frame fisheye images will 
result in sections containing no image data, 
which are filled with the color selected in the 
Fill color menu.

The Distortion Control slider controls distor-
tion. High values curve the image outward, 
while lower values curve it inward.

n Fisheye
Select Fisheye to process photos taken with fisheye lenses so that they appear to 
have been taken with a wide-angle rectilinear lens. An area at the center of the 
image (circular fisheye lenses) or centered around lines drawn horizontally and 
vertically through the center of the image (full-frame fisheye lenses) is cropped 
to match the camera picture angle.

Full-frame fisheye Circular fisheye
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LCH
The LCH color space models color using values 
for lightness (a property similar but not identi-
cal to brightness or luminance), chroma (color 
saturation), and hue. These parameters can 
be accessed via the channel menu in the im-
age adjustment palette when the LCH tool is 
selected.

n Master Lightness
Adjust overall lightness without affecting 
chroma or hue.
q Auto Contrast: Increase contrast by setting 

the white and black points to exclude 
a set proportion of the brightest and 
darkest pixels in the image.

w Add Anchor Point: Click this button and 
then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the lightness of the pixel 
under the cursor.

e Reset Current Channel: Reset the master 
lightness curve to linear.

r Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue 
curves to linear.

t White-point output-level slider: Choose the 
maximum output level (white point).

y Histogram: The histogram shows how the pixels in the image are distributed 
with respect to lightness. The horizontal axis corresponds to lightness (in the 
range 0–255), the vertical axis to the number of pixels.
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u Luminosity curve: The slope and shape of the curve determines the lightness of 
the image in the corresponding portion of the tone range.

i Black-point output-level slider: Choose the minimum output level (black point).
o Black-point input slider: Choose the minimum (black point) input level.
!0 Gamma: Choose the midpoint (gamma value).
!1 White-point input slider: Choose the maximum (white point) input level.

n Color Lightness
Adjust the lightness of selected colors 
without affecting chroma or hue. This can 
be used, for example, to brighten the blue 
of a dark skies.
q Add Anchor Point: Click this button and 

then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the value for the pixel un-
der the cursor.

w Reset Current Channel: Reset the color light-
ness curve to linear.

e Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue 
curves to linear.

r Color lightness curve: Moving a point on 
the curve upwards makes colors in 
the affected portion of the color range 
brighter, while moving it downward makes the affected colors darker.

t Width slider: Adjust the width of the curve that passes through the selected 
point, increasing or decreasing the range of colors affected by the change.

qwe
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n Chroma
Increase or decrease color saturation over 
the entire image or a portion of the color 
range, making colors more or less vivid.
q Add Anchor Point: Click this button and 

then click the image in the preview 
palette to add a point to the curve cor-
responding to the chroma of the pixel 
under the cursor.

w Reset Current Channel: Reset the chroma 
curve to linear.

e Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue 
curves to linear.

r Chroma curve: Moving a point on the 
curve upwards makes colors in the af-
fected portion of the color range more 
vivid, while moving it downward makes 
the affected colors less vivid (grayer).

t Output slider: Increase or decrease the saturation of all colors in the image.
y Width slider: Adjust the width of the curve that passes through the selected 

point, increasing or decreasing the range of colors affected by the change.
u Exclude Gray: Increasing chroma may make neutral colors (grays) seem over-

saturated. Select this option to increase chroma without affecting grays.
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n Hue
Map selected colors in the original (input) 
image to a specific range of colors in the fi-
nal (output) image. One application might 
be to deepen the colors in a pale blue sky.
q Add Anchor Point: Click this button and 

then click the image in the preview pal-
ette to add a point to the curve corre-
sponding to the hue of the pixel under 
the cursor.

w Reset Current Channel: Reset the hue curve 
to linear.

e Reset All Channel: Reset the master light-
ness, color lightness, chroma, and hue 
curves to linear.

r Scale: Click to change the vertical scale 
from 60  ° through 120  ° to 180  ° and 
back again (in this case the degrees re-
fer to a 360 ° color wheel). Increasing the scale increases the range of hues 
visible in the display, while decreasing the scale increases precision.

t Hue curve: Select a point on the curve that corresponds to the desired input 
color and drag it up or down until it intersects with the desired output color.

y Output slider: Modify the hue of all colors in the image.
u Width slider: Adjust the width of the curve that passes through the selected 

point, increasing or decreasing the range of colors affected by the change.
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Straighten and Perspective Control
Straighten pictures or correct for the effects of 
perspective.

n Straighten
Straighten pictures by up to ±10°. Choose 
lower values to rotate the picture to the left, 
higher values to rotate it to the right. To hide 
the effects of straightening, remove the check 
from the Straighten checkbox.
To straighten pictures manually, click the 
straighten tool in the image adjustment pal-
ette and drag the cursor parallel to a line in 
the preview (this option can not be used with 
thumbnails; page 10). The image will be rotat-
ed by up to ±10  ° to make the reference line 
horizontal or vertical, and the degree of rota-
tion will be displayed in the text box in the im-
age adjustment window. Unless Include areas 
without image data is selected, the image will automatically be cropped to re-
move any empty corners.

Drag cursor parallel to reference line Image rotated to make reference line horizontal 
and cropped to remove empty corners

Straighten tool

n Include Areas Without Image Data
Select this option to fill empty corners with black.

Drag cursor parallel to reference line Image rotated to make reference line horizontal 
and with empty corners filled in black

n Perspective Control
Correct the effect of perspective on, for example, photos taken with the camera 
angled up to frame a tall building. Perspective can be adjusted vertically and 
horizontally by up to ±20.

Vertical: 20 Horizontal: 20

n Show Grid
Select this option to display a grid. The grid 
color and spacing can be selected in the 
“View” tab of the preferences dialog (page 46).
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Unsharp Mask
Increase sharpness by making edges more dis-
tinct. The contrast of edges is increased while 
other areas are left untouched.
q Delete: Delete the currently-selected 

mask from the unsharp mask list.
w Move Up/Move Down: Move the currently-

selected mask up or down in the un-
sharp mask list.

e Unsharp mask list: A list of unsharp masks, 
identified by color channel, intensity, 
halo width, and threshold (e.g., “Red, 
50%, 10%, 0”). Masks apply in the order 
listed; to change the order, use the up/
down buttons.

r Color: Choose the color channel to which 
the unsharp mask applies.

t Intensity: The amount edge contrast will 
be increased.
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y Radius: The greater the radius, the wider the edges in the sharpened image 
will appear.

u Threshold: The limit at which sharpening will be applied. If the threshold is 
zero, sharpening will apply to all pixels in the image. Increasing the threshold 
increases the amount of contrast that must be present between pixels before 
the mask will be applied, with the result that only more distinctly contrasting 
edges will be affected.
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Levels & Curves
Adjust contrast, tone (brightness), and color 
balance. Adjustments can be made over the 
entire image or to specific portions of the tone range (for example, the gamut of 
a specific printer, monitor, or other output device), allowing enhancements to be 
made without sacrificing detail.
q Channel: The current color channel.
w Auto Contrast: Increase contrast by set-

ting the white and black points to ex-
clude a set proportion of the brightest 
and darkest pixels in the image, creat-
ing a curve that makes optimal use of 
the output tone range while preserv-
ing details in shadows and highlights.

e Set Black Point: Click this button and then 
click the image in the preview palette 
to set the black point for the red, green, 
and blue channels to the value for the 
pixel under the cursor.

r Set Neutral Point: Click this button and 
then click the image in the preview pal-
ette to adjust gamma for the red, green, 
and blue channels to equalize the RGB 
values for the pixel under the cursor.

t Set White Point: Click this button and then click the image in the preview pal-
ette to set the white point for the red, green, and blue channels to the value 
for the pixel under the cursor.

y Add Anchor Point: Click this button and then click the image in the preview area 
to add a point to the curve corresponding to the value of the pixel under the 
cursor.

u Reset Current Channel: Reset the curve for the current channel to linear.
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i Reset All Channel: Reset all curves to linear.
o White-point output-level slider: Choose the maximum output level (white point). 

Dragging the slider down lowers the brightness of the brightest pixels.
!0 Histogram: The histogram shows how the pixels in the image are distributed 

with respect to brightness. The horizontal axis corresponds to brightness (in 
the range 0–255), the vertical axis to the number of pixels.

!1 Tone curve: The slope and shape of the curve determines the brightness of the 
image in the corresponding portion of the tone range.

!2 Black-point output-level slider: Choose the minimum output level (black point). 
Dragging the slider up increases the brightness of the darkest pixels.

!3 Black-point input slider: Any pixels in the portion of the tone range to the left of 
the black point are output at the minimum output level. Dragging the slider 
to the right steepens the curve and enhances contrast but may cause loss of 
details in shadows.

!4 Gamma: Dragging the slider to the left increases the brightness of mid-tones, 
while dragging it to the right makes mid-tones darker.

!5 White-point input slider: Any pixels in the portion of the tone range to the right 
of the white point are output at the maximum output level. Dragging the 
slider to the left steepens the curve and enhances contrast but may cause 
loss of details in highlights.

A Sampling the Current Channel
By default, the black point, white point, add anchor point, and auto contrast controls respectively set 
the black point, anchor points, white point, and contrast for all channels. To apply these controls only 
to the current channel, press Ctrl (or on Mac computers, the option key) while clicking the control.
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Copying Adjustments
Image adjustments can be copied and applied to other pictures, speeding the 
process of enhancing pictures taken under similar conditions.

Adding Adjustments to the Tool List
Current settings can be added to the menus in the tool list.

 1 Select a tool from the tool list and adjust 
settings in the adjustment palette. Here 
we have set exposure compensation 
(page 20) to +1.50.

 2 Select Register Adjustments from the 
pull-down menu in the tool list.

 3 Enter a name for the new setting and click 
OK. In this example, we have named the 
setting +1.5.

The new setting is added to the pull-down 
menu and can now be applied to other 
pictures.

AA Selecting Edit Registered Adjustments from 
the pull-down menu displays a dialog where you 
can rename or delete previously-saved settings.
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The Adjustment Manager Tool
The adjustment manager can be used to apply multiple adjustments simultane-
ously.
• Copy Updated Adjustments: Copy all adjustments 

that have been changed since the current 
folder was selected.

• Copy All Adjustments: Copy all adjustments.
• Paste Adjustments: Apply adjustments copied 

using Copy Updated Adjustments or Copy 
All Adjustments to the currently-selected 
image or images.

• Save Updated Adjustments: Save all adjustments 
that have been changed since the current 
folder was selected.

• Save All Adjustments: Save all adjustments.
• Load Adjustments: Select an adjustments file 

saved using Save Updated Adjustments or 
Save All Adjustments and apply it to the cur-
rently-selected image or images.

• Register Updated Adjustments: Any adjustments 
that have been changed since the current 
folder was selected are saved and added as 
an option to the adjustment manager pull-
down menu.

• Register All Adjustments: All current adjustments are saved and added as an op-
tion to the adjustment manager pull-down menu.

• Edit Registered Adjustments: Reorder, rename, or delete adjustments previously 
added to the adjustment manager pull-down menu.

n Copying Adjustments to Other Pictures
Follow the steps below to copy adjustments and apply them to other images.

 1 Adjust settings in the edit palette. Here we have set exposure compensation 
(page 20) to –1/2 EV and selected the Vivid Picture Control (page 22).

 2 Click the adjustment manager  icon 
and select Copy Updated Adjustments or 
Copy All Adjustments from the options in 
the adjustment palette. Here we have se-
lected Copy All Adjustments.

 3 Select images. In this example, the selected image has already been ad-
justed using the exposure compensation (page 20) and white balance (page 21) 
tools.
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 4 Click the adjustment manager  icon and 
select Paste Adjustments from the op-
tions in the adjustment palette.

The adjustments copied in Step 2 are applied to the images selected in 
Step 3. Because we selected Copy All Adjustments in Step 2, exposure com-
pensation changes to –1/2 EV while white balance reverts to Original.

AA Had we selected Copy Updated Adjustments in Step 2, the exposure compensation and 
Picture Control for the selected image would have been set to the values selected in Step 1, 
while white balance would have remained at the value selected in Step 3.

n Copying Adjustments to Other Computers
The Save Updated Adjustments and Save All 
Adjustments options save image adjustments 
to a file which can be copied to other computers. 
The adjustments can then be applied to selected 
pictures on the other computers using Load 
Adjustments.

n Adding Adjustments to the Adjustment Manager
Use the Register Updated Adjustments and Register All Adjustments options 
to add adjustments to the adjustment manager pull-down menu.

A Copying Adjustments from RAW to JPEG or TIFF Images
When adjustments are copied from RAW (NEF/NRW) to JPEG or TIFF images, exposure compensa-
tion, Picture Controls, and other settings that are available only with RAW images will not be applied.
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File Format
To save RAW (NEF/NRW) images in JPEG or TIFF format, click the  button in the 
toolbar.

A dialog will be displayed where you can choose a file format and adjust such 
settings as compression and image size. Click Start to copy the file or files in the 
selected folder.
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q File format: Choose from JPEG, TIFF (8 Bit), and TIFF (16 Bit).
w Quality (JPEG only): Use the slider or pull-down menu to choose a value between 

0 and 100. The higher the value, the lower the compression ratio and the 
higher the image quality; the lower the value, the higher the compression 
ratio and the smaller the file size.

e Use LZW compression(TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

AD LZW compression may sometimes increase file size when applied to 16-bit images.

r Resolution: Select this option to choose the output resolution.
t Embed ICC profile: Select this option to embed the current color profile in the 

image.
y Specify size: Select this option to resize pictures saved in the new format. The 

new size can be entered in pixels, centimeters, or inches. When you enter a 
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.

u Use source folder: Save copies in the same folders as the originals.
i Use source file name: Save copies under the same file names as the originals. 

Two-digit numbers will automatically be added in ascending order to the file 
names if files with the same names as the original already exist in the selected 
folder.

o Save in: If Use source folder is not selected, click Browse... to select a destina-
tion folder.

!0 File name: If Use source file name is not selected, click Edit... to name the cop-
ies using selected prefixes, suffixes, and sequential numbering.
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Cropping Pictures
To crop unwanted areas from images, click the  button in the toolbar.

The crop palette will be displayed. Follow the steps below to crop images.
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q Aspect Ratio The crop aspect ratio. Choose Free Crop to select a crop with no fixed aspect ratio.

w
Custom 
Aspect Ratio

For custom aspect ratios not listed in the aspect ratio menu, select Custom and enter the 
desired aspect ratio.

e Rotate Crop Rotate the crop 90°.

r Show Grid Display an evenly-spaced 3 × 3 grid inside the crop.

t Reset Crop Reset the current crop.

y Cancel Cancel the current crop.

u Apply Ratio Apply the current crop.

 1 Choose an aspect ratio in the crop palette (to select a free crop with no fixed 
aspect ratio, choose Free Crop).

AA The aspect ratio can be changed after you have resized and positioned the crop.

 2 Drag the cursor over the image to select the crop. The area outside the crop 
is shown in gray.
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 3 Drag the corners of the crop to resize it without changing the aspect ratio.

AA To reset the crop, click Reset Crop.

 4 Double-click inside the crop or click the Apply Ratio button in the toolbar to 
crop the image.

A Crop
Crops are not applied to the original image data and can be changed at any time by clicking the  
button in the toolbar. This also applies in the case of images cropped using ViewNX 2 or ViewNX-i.

Crops are applied when images are converted to JPEG or TIFF (page 36). When NEF/NRW (RAW) im-
ages cropped in Capture NX 2 are opened in Capture NX-D, the crop is treated as the entire image; 
to select a crop that extends outside these bounds, click the revert button (page 19) to restore the 
original image and then select the desired crop.
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Removing Dust and Scratches
Dust and scratches can be removed using the retouch brush tool.

Clicking the  button in the toolbar displays the retouch brush palette.

 1 Choose the brush size.

 2 Keeping the mouse button pressed, drag the brush over the defect. The af-
fected area is shown by a translucent red line; continue until the defect is 
completely covered.

 3 Release the mouse button to apply the tool to the affected area.

A Brush Size

A brush larger than the defect you are attempting to correct may affect neighboring areas of the 
image.

A The Auto Retouch Brush

The retouch brush copies data from surrounding areas of the image automatically and pastes it over 
the defect. It may not produce the desired results if defects are widespread, the tool is dragged a 
long distance, or the affected is very large. The time required to complete processing varies with the 
image.

A The Retouch Palette

Clicking the  button in the toolbar or the  tool but-
ton in the edit palette displays the retouch palette. Select 
or deselect Auto Retouch Brush to show or hide the 
effects of the retouch brush, or undo the effects of the 
brush by clicking Clear.
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Batch Processing
The File > Run Batch Process option can be used to perform the same image 
adjustments on all pictures in a selected folder and then export the processed 
images in a selected file format. Batch processing options are shown below.
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q Source folder: Click Browse to choose a source folder. To include all images in 
sub-folders under the selected folder, select Include subfolders.

w Adjustments: Select Apply current adjustments to process the images using 
the adjustments for the current image. To apply adjustments previously 
saved from the adjustment manager, choose Adjustments to apply and click 
Browse to choose an adjustments file. To export the images in the selected 
folder in another format without changing the settings currently selected for 
each image, choose Apply adjustments already in files.

e File format: Select the format in which the processed files will be saved. Choose 
from JPEG, TIFF 8 bit, and TIFF 16 bit.

r Quality (JPEG only): Use the slider or pull-down menu to choose a value between 
0 and 100. The higher the value, the lower the compression ratio and the 
higher the image quality; the lower the value, the higher the compression 
ratio and the smaller the file size.

t Use LZW compression (TIFF only): Compress TIFF files using “lossless” LZW compres-
sion.

AD LZW compression may sometimes increase file size when applied to 16-bit images.

y Resolution: Select this option to choose the output resolution.
u Embed ICC profile: Select this option to embed the current color profile in each 

image.
i Specify size: Select this option to resize pictures saved in the new format. The 

new size can be entered in pixels, centimeters, or inches. When you enter a 
value for either Long edge or Short edge, the remaining value will automati-
cally be adjusted to maintain the original aspect ratio.

o Destination: Select Use source folder to save the processed files to the current 
folder. To choose a different folder, remove the check from this option and 
click Browse. To save the processed files under the same names as the origi-
nals, select Use source file name (if a file with the same name and extension 
already exists in the current folder, the processed file will be renamed by add-
ing a number to the file name); to choose different names, remove the check 
from this option and click Edit.
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Clicking Start starts processing and displays a progress dialog. Progress can be 
viewed in the Queued and Finished tabs.
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Queued Finished

q Source: A list of the files that are awaiting processing or have been processed.
w Automatically Show/Hide: Removing the check from this option hides the prog-

ress dialog. The progress dialog can be displayed by clicking the  button in 
the toolbar.

e Delete: Click to remove the file selected in the Queued tab from the queue, or 
to delete the log for the file selected in the Finished tab.

r View folder: Open the destination folder in the operating system file browser.

D Color Efex Pro
If the source contains files modified using the Color Efex Pro plug-in for Capture NX 2 or Capture NX, a 
message will be displayed and the images will not be processed.

A File Conversion
If multiple files are selected when the  button in 
the toolbar is used to export files in another format 
(page 36), the files will be exported as a batch process. 
Adjust settings as described for items e through o 
on page 40.



Capture NX-D Reference Manual 42

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

Printing Pictures
To print pictures on a printer connected to the computer, select the pictures and 
choose Print in the File menu. The “Print” dialog will be displayed.

Adjust settings as described on the following page and click Print to print the 
picture as shown in the preview.

The “Print” Dialog

Print Type

• Full Page: Print one picture per page.
• Index Print: Print multiple images per page (page 44).
• Standard Photo Sizes: Print pictures at a standard photo size. Capture NX-D automatically 

chooses the number of pictures printed on each page.

Printer Setup

Printer Click Settings to choose the printer and paper size and adjust other printer settings.

Printer Type Choose Inkjet when printing on an inkjet printer.

Print Priority
When printing NEF/NRW (RAW) pictures, choose Speed to use the preview data embed-
ded in the image for faster printing, or Quality to use the original image data for higher 
quality output.

Copies Choose the number of copies of each page printed.

Page Layout

Rotate to fit Rotate pictures to print them at the largest possible size.

Crop images 
to fit

Pictures are enlarged to fill the print area. Portions that do not fit in the print area are 
cropped out.

Background 
Color Choose the background color. Choose White to print with no background.

Border width Choose the width of the borders printed around the image (the color of the borders varies 
with the background color). Choose 0 to print without borders.

Copies of 
each image Choose the number of copies of each photo printed.

Print 
 Information Print the file name, date of recording, or photo information under each picture (page 43).

Use thumb-
nail data 

(draft mode)

Print using thumbnail data. Images print faster, but at lower quality. Some images will print 
using the original file data even when this option is selected.

Specify color 
profile

Click Settings... to select the color profile used for printing (Profile) and choose an 
Intent from Perceptual and Relative colorimetric (page 45).

A Notes on Printing
To print to a JPEG file, click File Output.
The most recently-used settings are recalled when the print dialog is next displayed.
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Printing Image Information
To choose the information printed under each picture, select Print Information 
in the “Print” dialog (page 42), click Settings, and adjust the settings described on 
the following page.

Advanced Print Information Settings

Date/Tim
e Shot and Com

m
ent

Date Shot Print the date of recording in the position selected for Position.

Time Shot Print the time of recording together with the date.

User Comment Print the comment entered in the text box.

Font Settings Choose the font, style, font point size, and color used to print the date/time stamp. The 
results can be previewed in the “Sample” area.

Metadata Choose the file and photo information printed with each picture. The font, style, and font 
point size can be selected in the “Font Settings” area and previewed in the “Sample” area.

Header/Footer

Header Enter the text and choose the alignment for the header that will be printed at the top of 
each page.

Page 
Number

Choose whether to print the page number and the total number of pages and select the 
position and alignment. The page number can be positioned at the page Top (in the 
header) or Bottom (in the footer).

Footer Enter the text and choose the alignment for the footer that will be printed at the bottom 
of each page.

Font Settings Choose a font, style, and font point size for the header, footer, and page number. The 
results can be previewed in the “Sample” area.

D Print Information
Print information is not rotated when Rotate to fit is selected in the “Print” dialog. Metadata that 
does not fit in the print area will be omitted.
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Index Prints
To print multiple images per page, select Index Print for “Print Type” in the “Print” 
dialog (page 42). The options in the “Page Layout” area will change; choose the 
number of pictures printed per page.

Layout
Choose a layout. 

n Standard
Choose the number of pictures per page from a list 
box. The size of the pictures is automatically adjusted 
according to the option selected.

A 2 × 4 layout

n Image Size
Pictures are printed at the size entered for “Width” and 
“Height” (the minimum size is 20.0  mm  × 20.0  mm 
and the maximum the same as the page size). The 
number of pictures per page is automatically adjust-
ed according to the size selected.

Pictures printed at 50 mm × 50 mm

n Column and Row
Choose the number of columns and rows printed per 
page (the minimum is 1 and the maximum 10). The 
size of the pictures is automatically adjusted accord-
ing to the options selected.

A 3 × 3 layout

n Images Per Page
Choose the number of images printed per page. The 
images will automatically be resized according to the 
number selected.

An 8 × 8 layout

Margins
Choose the width of the margins.
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Preferences
To modify the default behavior of Capture NX-D, select Preferences… in the Edit 
menu (or on Mac computers, the Capture NX-D menu). 

General

q
w
e

t

y

r

q Clear Cache: Clear the cache.
w Maximum capacity: Select a cache size.
e Specify cache folder: Select this option to choose a cache folder using the 

Browse… button. Use the Existing cache handling menu to choose what to 
do with the existing cache.

r Display preview image faster: If this option is selected, Capture NX-D will generate 
preview data as modifications are made for faster preview display.

t Maximum thumbnail width: Choose the maximum thumbnail width, in pixels 
(page 10).

y Restore Defaults: Reset all items in the “General” tab to their default values.

Color Management

q

w

q Default RGB color space: Choose the default RGB color space for image display.
w Use this profile when printing: Select this option to choose a color profile for print-

ing from the Profile menu. Choose the Intent from Perceptual and Relative 
colorimetric.

A Intent
Perceptual maintains the relations between colors to produce results that seem natural to the hu-
man eye. The colors may however not be true to the original image data. Relative colorimetric 
maps colors not in the selected profile to the nearest available color. All colors in the gamut of the 
printer will be reproduced accurately.
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Preferences

Levels & Sampling

q

e

w

q Auto-contrast clip: The levels and curves auto contrast option (page 32) increases 
contrast by setting the white and black points to exclude a set proportion of 
the brightest and darkest pixels in the image. Choose the percentage of pix-
els excluded by the new Black and White points.

w Dropper sample size: Select the size of the area sampled by the gray point (page 21) 
and levels and curves (page 32) sampling controls. Choose from Point sample 
(a single pixel), 3×3 Average (the average of an area 3 pixels square) and 5×5 
Average (the average of an area 5 pixels square).

e Restore Defaults: Reset all items in the “Levels & Sampling” tab to their default 
values.

View

q

e
w

r

t

q Size of Text and Icon: Choose the size of the letters and icons in the user interface.
w Color: Choose a color for the reference grid.
e Gridline every: Choose the grid spacing.
r Subdivisions: Choose the number of subdivisions in each square.
t Restore Defaults: Reset all items in the “View” tab to their default values.
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Preferences

NEF (RAW) Processing

q

w

e

r

q Color Space for Color Reproduction: Choose the color space used for adjustments to 
RAW (NEF/NRW) images.

w Sizes Medium/Small for NEF (RAW) Images: Select this option for optimal processing 
when editing small and medium RAW (NEF/NRW) images.

e D1X RAW Default: Choose the default display size for RAW (NEF) photos taken 
with the D1x. Choose from 6MP (3008 × 1960) and 10MP (4016 × 2616).

r Color Reproduction Process: Choose a color reproduction process (page 22).

Open with Application

w

q

q Open With Application: Edit the list of applications that can be accessed via the 
Open With option in the File menu (page 49) and choose the format (TIFF (16-
bit), TIFF (8-bit), or JPEG) used when images are opened in other applica-
tions.

w Folder to Place Open With file: Before being opened in other applications, images 
are converted to the format selected using Open With Application. Use this 
option to choose where the converted files are stored.
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Preferences

Dialog/Alert

q

q Dialog Windows: Click Reset to reset the “Don’t show this dialog again” check 
boxes for all dialogs.



Capture NX-D Reference Manual 49

Introduction Viewing Pictures Filters Image Adjustment Other Features Menu Guide

Menu Guide

The Capture NX-D Menu (Mac Only)
• About Capture  NX-D: Display the product version 

number.
• Preferences: Open the Capture NX-D preferences 

dialog (page 45).
• Quit Capture NX-D: Quit Capture NX-D.

The File Menu
• New Folder: Create a new sub-folder in the 

current folder.
• Rename Folder: Rename the current folder.
• Launch Camera Control Pro 2: Launch 

Camera Control Pro 2.
• Synchronize Edits: Select this option to ap-

ply current settings to any images subse-
quently added to the current folder.

• Open with ViewNX-i: View the current image 
or images in ViewNX-i. The images are dis-
played in their current state including any 
changes made using Capture NX-D and, in 
the case of NEF/NRW (RAW) images, with-
out conversion to TIFF. This option is only 
available if ViewNX-i is installed.

• Open With: Open the current image in another application. Use the Open With 
Application option to add applications to the menu (page 47).

• Open in Explorer (Windows)/Show in Finder (Mac): Open the current folder in the operat-
ing system file browser.

• Launch Picture Control Utility 2: Launch Picture Control Utility 2.
• Rename: Rename the current image.
• Convert Files: Convert the currently-selected image or images to JPEG or TIFF for-

mat (page 36).
• Run Batch Process: Perform batch processing (page 40).
• Page Setup: Adjust printer settings.
• Print: Print images (page 42).
• Exit (Windows only): Exit Capture NX-D.

The Edit Menu
• Undo: Undo the most recent operation.
• Redo: Redo an operation after performing Undo.
• Cut/Copy/Paste: Cut, copy, or paste the current selec-

tion.
• Delete: Delete the current selection.
• Select All: Select all images in the current folder.
• Select Inverse: Select all images in the current folder 

that are not currently selected and deselect any im-
ages that are currently selected.

• Deselect: Deselect all images.
• Select File: Select all files in the current folder that 

match the criteria chosen in the Select File submenu.
• Preferences (Windows only): Open the Capture NX-D preferences dialog (page 45).
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Menu Guide

The View Menu
• Go: Navigate the folder hierarchy.
• Thumbnail/Image Viewer/Preview/Full Screen: 

Choose how images are displayed 
(page 10).

• Compare Before and After Images/2 Images/ 
4 Images: Compare images (page 13). The 
4 Images option is available only on a 
computer with a 64-bit operating sys-
tem and at least 4 GB of memory.

• Thumbnail Size: Choose the thumbnail size 
(page 10).

• Sort Thumbnails by: Sort thumbnails.
• Filter: Filter images according to selected 

criteria (page 17).
• Zoom In/Zoom Out/Fit to Screen/View at 25%/

View at 50%/View at 100%/View at 200%/View 
at 400%: Zoom the preview in or out.

The Image Menu
• Next Image/Previous Image: View the next or previ-

ous image in the current folder.
• Rotate: Rotate the current image 90 or 180 de-

grees.

• Show Grid: Display a grid over the preview.

• Show Focus Point: Show the focus point in the pre-
view display.
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Menu Guide

• Show Lost Highlights: View areas of the image 
with the maximum value for brightness and in 
which details may have been lost to overexpo-
sure (“washed out”). A different color is used to 
show the lost highlights for each of the RGB, red, 
green, and blue channels.

• Show Lost Shadows: View areas of the image with 
the minimum value for brightness and in which 
details may have been lost to underexposure. A 
different color is used to show the lost shadows 
for each of the RGB, red, green, and blue chan-
nels.

• Apply: Label (page 16) or rate (page 15) selected images.

The Adjust Menu
• Revert to Original State: Reset all image ad-

justments and restore the picture to its 
original state.

• Revert to Last Saved State: Initialize the set-
tings file (page 3), cancelling all changes 
made in Capture NX-D.

• Copy Updated Adjustments: Copy only those ad-
justments that have been changed since the 
current folder was last opened.

• Copy All Adjustments: Copy all adjustments.
• Paste Adjustments: Apply to the current image adjustments copied using Copy 

Updated Adjustments or Copy All Adjustments.
• Save Updated Adjustments: Create a file containing only those adjustments that 

have been changed since the current folder was last opened.
• Save All Adjustments: Save all adjustments to a file.
• Load Adjustments: Load adjustments from a file created with Save Updated 

Adjustments or Save All Adjustments and apply them to the current image.

A Using “Revert to Original State” with Images Modified in Other Applications
In the case of JPEG and TIFF images modified in Capture NX 2 or ViewNX 2, Revert to Original State 
reverts the image to its last saved state.
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Menu Guide

The Tool Menu
• Fit: Double-click the display to alternately zoom the 

preview to fit the palette and zoom to a 100% view.
• Combination Tool: As above, except that the preview 

can be scrolled by dragging the cursor.
• Zoom Tool: Click to zoom in. To zoom out, click while 

pressing the Alt key (or on Mac computers, the 
option key).

• Hand Tool: Drag to scroll the preview.
• Gray Point Sample Tool: Set white balance by sampling the preview (page 21).
• Crop Tool: Crop the preview (page 37).
• Straighten Tool: Straighten the image in the preview palette (page 30).
• Auto Retouch Brush Tool: Remove dust and scratches (page 39).

The Window Menu
• Histogram/Edit/Metadata/Bird’s Eye/Folders: View or hide 

the selected palette.
• Show Tool Bar: View or hide the toolbar.
• Show Status Bar: View or hide the status bar.
• Show Pallets: View or hide all palettes.
• Customize Toolbar: Customize the toolbar (page 8).

The Help Menu
• Capture NX-D Help: View online help.
• Check for Updates: Check for updates to Capture NX-D.
• About Capture NX-D (Windows only): Display the product ver-

sion number.




